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The Registration Process

●     Overview 
●     Understanding the Registration Process 
●     Automated Asset Registration Using Advanced Registration Flows 
●     Accepting a Submission 
●     Registering an Asset 
●     Completing the Tab Approval Process 
●     Administration Tab 
●     Audit Log, Reviews, and Notes 

Overview

Assets determined to be appropriate for reuse are submitted to the repository. Submitted assets are reviewed 
by the registrar, who determines which assets will proceed through the registration process.

Assets accepted by the registrar enter the registration work queues. The submitter can track the asset's 
progress toward registration using the My Submissions folder on the My Stuff page. Submitters are notified 
about rejected assets and the reason for rejection (for instance, a duplicate asset).

Understanding the Registration Process

Assets moving through the registration process are organized and managed via several folders, as displayed in 
the file tree in the Asset Editor.
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An asset begins the registration process in the Pending Review folder, under the Submitted folder. 
Once accepted or rejected by the registrar, the asset moves to the Under Review folder, under Submitted.

Pending registrar review and approval of the data on the tabs in the Asset Editor, the asset moves from 
Under Review to the Registered folder. Users can track the progress of assets by using the Search 
function, which accesses Submitted, Unsubmitted, and Registered assets, or by using My Stuff.

The registration process includes the following actions: 

●     Submission
�❍     An asset is submitted by a user and appears in the Pending Review folder under Submitted. An automatic 

email message alerts the registrar that a new asset has entered the submission queue. 

●     Review
�❍     The Registrar examines the asset and its associated information and makes a decision to accept it, which enters 

it into the work queues. The Registrar may also choose to reject the asset. 
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●     Rejection
�❍     If the asset is rejected, the registrar enters a reason for the rejection. 

�❍     When an asset is rejected from the submission folder, it is removed from the Asset Editor and marked as 
rejected in the submitter's My Submissions folder in My Stuff. 

●     Acceptance
�❍     Once an asset is accepted, it can be assigned to one or more Registrars for processing and approval. 

Registrars can view assets assigned to them from My Stuff. Assets accepted for registration move to the 
Under Review folder, and the registrar or advanced submitter begins the registration process. The 
required information is gathered and entered on the appropriate tabs in the Asset Editor. The registrar 
examines each tab and monitors the workflow. When information for a specific stage of the workflow is 
acceptable, the registrar approves the data on the appropriate tab. There is no prescribed order in the 
approval process; the registrar can approve any stage in any order. The registrar also has the option to edit any 
of the information for any stage of the process. 

●     Approval
�❍     The registrar grants final approval on the Administration tab, based on organizational standards regarding 

the information supplied on each of the various tabs. The specific configuration of Asset Editor tabs for any asset 
is determined by the Type template to which the asset is assigned on submission. Each tab provides 
various elements for metadata that is used to describe the asset and facilitate its use. 

Automated Asset Registration Using Advanced Registration Flows

The Oracle Enterprise Repository bundles pre-built BPM asset registration flows that attempt to automate 
the registration and governance processes defined in Understanding the Registration Process. For ease of 
use, you can use the predefined OBPM endpoint or create your own Web Service endpoints to subscribe to 
Oracle Enterprise Repository events. You may use the OBPM Designer to create new Governance 
workflows. There are also event monitoring and logging tools for troubleshooting and tuning purposes.

For more information about using the Advanced Registration Flows feature, see the Oracle Enterprise 
Repository "Configuring and Managing Advanced Registration Flows" documentation.

Accepting a Submission

This procedure is performed in the Asset Editor. (Requires appropriate permission.)

1.  Open the Submitted folder. 

2.  Open Pending Review. 

3.  Select the asset to be registered.
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4.  Options:

�❍     Click Accept.

The asset moves to the Under Review folder in the tree, and also appears in each of the workflow folders 
under the asset. The workflow folders correspond to tabs in the Asset Editor.

�❍     Click Accept and Assign

The Assigning Users popup opens.

1.  Use the << and >> buttons to move items between the Available Users and Selected Users columns. 

2.  Click OK

The asset moves to the Under Review folder in the tree and is assigned to the selected user/users, who will 
provide the information required for each of the tabs in the Asset Editor. The assignees also may receive a 
notification e-mail that lets them know they are assigned to this asset.

Registering an Asset

While certain tabs are common to all asset types, the specific Asset Editor tabs for any asset are determined 
by the configuration of the Type template to which the asset is assigned on submission.

Overview Tab
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1.  Click the Overview tab.

2.  Enter the appropriate information in each of the fields. 

3.  Click Approve.

The text in the Overview tab changes color and the Approve button changes to Unapprove.
�❍     Note: Approval buttons in the Asset Editor are visible only to users with the appropriate permissions. 

Taxonomy Tab

1.  Click the Taxonomy tab.
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Several Categorizations are displayed.

2.  Click the Assign button in the Classification section.

The Assign Classifications pop-up opens.

3.  Use the radio buttons to select the appropriate classification.

�❍     Approved
■     Approved by the Registrar for use in projects. 

�❍     Educational
■     For educational/informational purposes only. Not approved for use in projects. 

�❍     Mandated
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■     Must be used whenever a project requires the functionality the asset provides. (This is especially relevant for 
Web services that access customer data, process payments, etc.). 

�❍     Raw
■     No assurance of quality or completeness. 

�❍     Recommended
■     Approved and successfully deployed in at least one project. 

4.  Click OK.

The selections are listed in the Classifications section.

Note: Default Categories may be customized to reflect your environment.

5.  Repeat the process for each section in the Taxonomy tab. 

6.  Enter an appropriate keyword in the text box in the Keywords section. 

7.  Click Add.

The new keyword appears in the Keywords list.

Add other keywords as necessary.

8.  When the Taxonomy tab is completed, click Approve.

The text in the Overview tab changes color and the Approve button changes to Unapprove.

Documentation Tab

1.  Click the Documentation tab.
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A number of suggested document titles are listed in the Documentation window. Appropriate documentation 
may be associated with each of these titles, and new documents may be added to the list.

To add a new document:

2.  Click Add.

The Edit pop-up opens.

3.  Enter the appropriate information in the Name text box. 

4.  Click the Edit button next to the URL text box.

The Edit URL pop-up opens.
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5.  Select Artifact Store File or External File, as appropriate. 

6.  Enter all necessary information in the available text boxes. 

7.  Click OK.

The new document appears in the list.

8.  To edit file information for an existing document, select the document, click Edit and repeat Steps 4-7. 

9.  When finished, click Approve.

Relationships Tab

1.  Click the Relationships tab. 

2.  Click the Add button.
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The Add Relationship pop-up opens.

3.  Use the Search or List All Active buttons to display assets in the Asset section of the pop-up. 

4.  Select an asset from the list. 

5.  Use the Relationship Type drop-down to select the appropriate relationship between the two assets.

Note: If necessary, click the Reverse Relationship button to reverse the relationship.

6.  Click OK when finished. 

7.  Repeat as necessary to add other asset relationships. 

8.  When finished, click Approve.

See the Oracle Enterprise Repository Administration Guide for information on configuring relationships.

Completing the Tab Approval Process

While certain tabs are common to all asset types, the specific Asset Editor tabs for any asset are determined 
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by the configuration of the Type template to which the asset is assigned on submission. Similarly, the 
metadata elements that appear on any tab are also determined by the Type configuration. While the specific 
tabs and elements may vary from Type to Type, the approval process for each tab involves the entry and/or 
review of the information in each element. Each time a user clicks Approve on a tab, they will be prompted to 
save their changes.

Process to approve a tab for a specific type configuration

1.  In the Oracle Enterprise Repository screen, click the My Stuff link. 
2.  In the My Stuff section, select Assigned Assets and then select the asset for which you would want to approve 

the tab(s). 
3.  Click the Edit button in the right-bottom pane of the page. The Asset Editor dialog opens. 
4.  Select the tab that you want to approve. 
5.  Review the information in that tab.

6.  Click the Approve button. You will be prompted to save the changes you made. 
7.  Click OK in the Select an Option dialog. 

8.  Go back to the Assigned Assets page and refresh to note the changes. In the Tab Approval Status pane, you 
will notice that Approved has one item against it.

Administration Tab

Every asset in Oracle Enterprise Repository has an Administration tab. Use the Administration tab to:

●     Track the asset Created, Submitted, Accepted workflow. 

●     Assign users to review and approve information on the other tabs. 

●     Change the asset's status:
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�❍     Active 
�❍     Inactive 
�❍     Retired 
�❍     Deleted 

●     View asset notes and reviews. 

●     Complete the registration process by clicking the Register button.

A registered asset can include unapproved tabs.

Whenever a tab is approved, a TabApprovedEvent is triggered. This event along with the tab name and 
certain other metadata is sent to the workflows for processing. This event is used by the Multi-Tier workflows 
where depending on the tab approved and depending on the configuration, the workflows will decide if the next 
tier in the approval process needs to be assigned or not.
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Also the users can wire the TabApprovedEvent to any of the pre-defined workflows such 
as ChangeAssetLifecycle etc. So, this is also tied to the Tab names.

Audit Log, Reviews, and Notes

Audit Log Entries

When an Asset is updated, a record of the User, date and action appears in the Audit Log. Logged changes include:

●     Asset Creation 
●     Asset Update 
●     Changes in an Asset's Registration Status 
●     Changes in an Asset's Active Status 
●     Completion of an approval tab. 

The log entry is added to the list in the Logs section on the asset's Administration tab. (It may be necessary 
to click the Refresh button in the Logs section.)

Adding a Note to the Asset

1.  Click Add Note in the File menu.

The Add a Note for... pop-up opens.

2.  Enter the appropriate information in the text box. 

3.  Click OK.

The note is added to the list in the Logs section on the asset's Administration tab. (It may be necessary to 
click the Refresh button in the Logs section.)

See the Oracle Enterprise Repository Administration Guide for more information on using the Asset Editor.
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Using the Asset Editor

●     Overview 
●     Launching the Asset Editor 
●     Configuring System Options 
●     Advanced Submission 
●     Asset/Compliance Template/Policy Migration 

Overview

The Asset Editor is used to administer assets and to configure assets and types. 
Categories, relationships, rejection reasons, repositories, and vendors are also configured 
within the Asset Editor.

The specifics of configuration depend on your organization's guidelines, and may differ 
slightly from the options discussed here.

Launching the Asset Editor

This procedure is performed on the Oracle Enterprise Repository Assets screen.

1.  Click Edit/Manage Assets.

The Asset Editor opens.
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Configuring System Options

A number of system options can be configured from the Actions menu in the Asset 
Editor.

●     Configure Acceptable Value Lists 
●     Configure Artifact Store 
●     Configure Categorizations 
●     Configure Relationships 
●     Configure Rejection Reasons 

Configure Acceptable Value Lists

Defines/identifies the single- and multiple-selection lists used as metadata elements in 
asset displays.

1.  Select Configure Acceptable Value Lists from the Actions menu.

The Configure Acceptable Value Lists window opens.
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2.  Click Add

The Add Acceptable Value List window opens.

3.  Enter an appropriate name in the List Name text box.
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4.  Enter an appropriate list item name in the text box next to the Add button. 

5.  Click Add. 

6.  Repeat Steps 4 and 5 as necessary to add additional list items. 

7.  When finished, click OK.

The new list appears in the Configure Acceptable Value Lists window.

8.  To edit any Acceptable Value List, select the list from the Configure Acceptable 
Value Lists window. 

9.  Click Edit.

The Edit Acceptable Value List window opens. (Same form as the Add 
Acceptable Value List window.)

10.  Make changes as necessary. 

11.  Click OK. 

Copyright (c) 2008, 2009, Oracle and/or its affiliates. All rights reserved. 20 of 106



Configure Categorizations

Categorizations determine how assets are organized and viewed. They can also be 
applied in a similar fashion to projects.

1.  Select Configure Categorizations from the Actions menu.

The Configure Categorizations window opens.

2.  Click Add.

The Add Categorizations window opens.

3.  Enter the appropriate information in each of the text boxes.
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4.  Select the Mutually exclusive assignment? check box if assets can be assigned 
to only one of the categorizations in this categorization type. 

5.  Select the Assignable to Projects? check box (if this option has been enabled by 

Copyright (c) 2008, 2009, Oracle and/or its affiliates. All rights reserved. 22 of 106



your Oracle Enterprise Repository Administrator) so assets can be assigned to 
projects. 

6.  If UDDI is enabled for your environment, then Oracle Enterprise Repository 
automatically creates tModelKeys for categorizations. If required, an administrator 
can assign specific UDDI Version 2 or Version 3 tModelKeys to any categorization. 

7.  Click Add to add sub-categorizations.

8.  When finished, click OK.

The new categorization appears in the Configure Categorizations window.

9.  To edit any Categorization, locate it in the list in the Configure Categorizations 
window. 

10.  Click Edit.

The Edit Categorization window opens. (Same form as the Add Categorizations 
window.)

11.  Make changes as necessary. 

12.  Click OK. 

Configure Relationships

Relationships define the connection, interaction, or interdependence between assets. If so 
configured, assets subject to a specific relationship to an asset that has been selected for 
use (that is, the Use - Download button has been clicked) may also be downloaded.

1.  Select Configure Relationships from the Actions menu.
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The Configure Relationships window opens.

2.  Click Add.

The Add Relationships window opens.

3.  Enter the appropriate information in each of the text boxes.
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(See Relationship Labeling Conventions for more information.)

4.  Make the appropriate selection in the Direction drop-down.

The selected direction affects the information displayed in the Source Asset and 
Target Asset text boxes. For example, in a two-way relationship, the target and 
source are interdependent, whereas Two-way -- order matters can be used to 
describe the relationship between sequential versions of an asset, i.e., the 
relationship between Asset v0.90 and Asset v1.0.

5.  Make the appropriate selection in the Make target assets available for download 
with the source asset checkbox. 

6.  When finished, click OK. 

7.  To edit any Relationship, locate it in the list in the Configure Relationships 
window. 

8.  Click Edit.

The Edit Relationships window opens. (Same form as the Add Relationship 
window.)

9.  Make changes as necessary. 

10.  Click OK. 
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Configure System-Supplied Relationships

There are also system-supplied relationships in Oracle Enterprise Repository with limited 
read-only functionality to end users. Unlike standard asset relationships, system-supplied 
relationships are used in a context that requires their name and direction to be immutable. 
Therefore, these relationships cannot be added, deleted, or modified by users, except 
where otherwise noted.

For for more information about this feature, see System-Supplied Relationships.

Configure Rejection Reasons

Determines the selection of Rejection Reasons available to users who reject previously 
used/downloaded assets. Rejection Reasons provide valuable local community feedback 
on assets.

1.  Select Configure Rejection Reasons from the Actions menu.

The Configure Rejection Reasons window opens.
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2.  Click Add.

The Edit Rejection Reasons window opens.

3.  Enter the appropriate text in the Rejection Reason text box. 

4.  When finished, click OK. 

5.  To edit any Rejection Reason, locate it in the list in the Configure Rejection 
Reasons window. 

6.  Click Edit.

The Edit Rejection Reasons window opens.

7.  Make changes as necessary. 
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8.  Click OK. 

Configure Artifact Stores

Determines where the files relevant to assets in Oracle Enterprise Repository are stored.

1.  Select Configure Artifact Stores from the Actions menu.

The Configure Artifact Stores window opens.

2.  Click Add.

The Create a new Artifact Store window opens.
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3.  Enter a name for the artifact store. 

4.  In the Type list, select a type for the artifact store.

�❍     Default Types:
■     FTP

■     Accesses files on an FTP server 

■     HTTP
■     Accesses files on a Web server 

■     HTTPS
■     Accesses files on a secure Web server 

■     UNC
■     Accesses files using a Windows or Samba share 

■     Raw URI
■     Access files via a raw URI. 

■     Raw SCM
■     Access files via a raw SCM. Allows the selection of SCM Types, 

including CVS, Perforce, and Other. The selected SCM type 
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automatically populates the Download Path URI Suffix field, 
but the field can be modified however necessary. 

�❍     Depending on the integration options included in your installation of Oracle 
Enterprise Repository, one or more of the following types may be available:  

■     Perforce
■     Accesses the Perforce source control management system 

■     PVCS
■     Accesses the PVCS source control management system 

■     ChangeMan DS
■     Accesses the ChangeMan DS source control management 

system 

■     ClearCase
■     Accesses the ClearCase source control management system 

■     CVS
■     Accesses the CVS source control management system 

(requires ViewCVS or similar product) 

■     FileStores
■     Accesses the ClearCase or other SCM control management 

system 

■     ClearQuest
■     Accesses the ClearQuest defect tracking system 

5.  Enter a hostname and path for the server. 

6.  Optional: Enter a username and password.

Exercising this option enables automatic login.

7.  When finished, click OK. 

8.  To edit any Artifact Store, locate it in the list in the Configure Artifact Stores 
window. 

9.  Click Edit.
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The Edit Artifact Store window opens. (Same form as the Create a new Artifact 
Store window.)

10.  Make changes as necessary. 

11.  Click OK. 

Configure Vendors

Defines/identifies vendors providing assets to the repository.

1.  Select Configure Vendors from the Actions menu.

The Configure Vendors window opens.

2.  Click Add.

The Add Vendor Name window opens.
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3.  Enter the appropriate information in the Name text box. 

4.  When finished, click OK. 

5.  To edit any Vendor, locate it in the list in the Configure Vendors window. 

6.  Click Edit.

The Edit Vendor Name window opens. (Same form as the Add Vendor Name 
window.)

7.  Make changes as necessary. 

8.  Click OK. 

Advanced Asset Submission

This function allows a user (with the appropriate privileges) to submit assets through the 
Asset Editor rather that through the Web Console. This allows the user to enter more 
asset details upon submission. This procedure is performed in the Asset Editor. (Access 
to the Asset Editor is determined by the role to which the user is assigned.)

1.  Open the File menu in the Asset Editor and select New

The Create a New Asset pop-up opens.
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2.  Enter the appropriate information in the Name and Version text boxes. 

3.  Select the appropriate Type template from the drop-down.

4.  Click OK.

The new asset appears in the Asset Editor.
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The asset is submitted for review and registration.

Asset/Compliance Template/Policy Migration

Overview

Migration refers to the transfer of metadata and files from one asset, compliance template, 
or Policy to another, usually of the same type. Since it is easier to edit metadata than to 
recreate it, this function allows users to quickly create different versions of assets, 
compliance templates, or policies. For example, in order to create JavaComponent v1.0, 
one would migrate the metadata and files from JavaComponent v0.90, then make the 
necessary changes in the metadata for the v1.0 asset. When migrating an asset the new 
asset must have a different name, version number, or both. Migration does NOT remove 
the original asset from Oracle Enterprise Repository.

It is also possible to migrate an asset, compliance template, or policy to a different type. 
However differing metadata elements will not transfer. For example, if the originating 
asset type uses a table on one of its tabs and is migrated to an asset type that does not 
have the same table element, the table and its metadata will not migrate. The table 
metadata element would have to be created in the new asset type.
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Migrating an Asset/Compliance Template/Policy

This procedure is performed in the Asset Editor.

1.  Use Search or browse the Asset Editor file tree to locate the source asset or 
compliance template to be migrated.

2.  Select Copy/Migrate in the File menu.

The Copy/Migrate window opens
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3.  Enter the appropriate information in the Name and Version text boxes. 

4.  Select the destination Type (the type to which the source artifact is to be migrated) 
in the Type drop-down.

Migrating assets between dissimilar types will affect the display of asset information 
in the asset detail and in the Asset Editor.

5.  When finished, click OK.

The migrated asset appears in the Asset Editor.
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6.  Click the new asset's Administration tab.
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7.  Register the new asset or assign it to another user for registration. 

Asset Registration Status

The registrar may assign a status to the asset using the Administration tab in the Asset 
Editor.

●     Active
�❍     The status assigned to any asset that is available for use. 
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●     Inactive
�❍     The status assigned to any asset in the repository but unavailable for general 

use. An inactive asset can be re-activated or retired. Inactive assets show up 
in a search, but cannot be selected for use (the Use - Download button is 
not displayed). 

●     Retired
�❍     The status assigned to any asset in the repository that is retired from general 

use. A retired asset can be re-activated or made inactive. Retired assets 
cannot be selected for use (the Use - Download button is not displayed), nor 
will they show up in a search; however, they will still be available as related 
assets to active or inactive assets in the repository. 

●     Deleted
�❍     The status assigned to any asset that is removed from the repository. 

Deleted assets cannot be recovered or have their status reassigned. 

Assigning or Changing an Asset's Status

This procedure is performed in the Asset Editor. Any changes to an asset's status are 
automatically saved by the Asset Editor.

1.  Use Search or browse the Asset Editor file tree to locate the source asset or 
compliance template to be migrated.

2.  Click the Administration tab 
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3.  In the Status drop-down list, select the status to be assigned to the asset.

Note: Depending on the assigned status, the asset may disappear from the tree 
(Deleted) or be unavailable for user searches (Retired).
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Oracle Enterprise Repository

Relationship Labeling Conventions

Relationship mapping and management is an important aspect of software asset portfolio 
management. Oracle Enterprise Repository includes pre-configured asset relationships, 
and also provides the means to create and manage custom relationships. Asset 
relationships provide valuable contextual information on assets and their use. When 
creating relationships, careful attention to labeling will promote greater understanding of 
the assets, and of the relationships that connect assets to each other, to the projects that 
produce and consume them, and to the policies that govern their creation and use.

Relationships are created and managed within the Oracle Enterprise Repository Asset 
Editor. (See the Oracle Enterprise Repository Registrar Guide, for more information on 
using the Asset Editor.)

The chart below lists examples of the labels for pre-configured Oracle Enterprise 
Repository asset relationships. These are only examples to be followed when creating 
new relationships.

 Relationship  Explanation 
 Prescribed Asset(s)  A Requires Asset B 
 Asset Prescribed by  Asset B is Required by A 
  
 Applied to  Rule A Applied to B 
 Subject to  B Subject to Rule A 
  
 Contains  A Contains B 
 Contained In  B is Contained in A 
  
 Implements  A Implements B 
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 Implemented by  B is Implemented by A 
  
 Next version is  B is the Next version of A 
 Previous version is  A is the Previous version of B 
  
 Prescribed Process(es)  Process A is applied to B 
 Process Prescribed by  B must follow process A 
  
 References  A References B 
 Referenced by  B is Referenced by A 
  
 Prescribed Environment(s)  A Requires Environment B 
 Environment Prescribed by  B is the Required Enviroment for A 
  
 Runs  A Runs B 
 Runs on  B Runs on A 
  
 Functional Equivalent of  A is the Functional Equivalent of B 
  
 Related To  A is related to B 
  
 Similar To  A is similar to B 
  
 Uses  A Uses B 
  
 Depends On  A Depends on B 
  
 Provides Business Service  Business Entity A is the service provider for Service B 
 Provided by Business Service  B is a Service Provided by Business Entity A 
  
 Applied policies  Policy A applies to asset B 
 Assets applied to  Asset B is subject to Policy A 
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Relationship Display

The labels assigned to relationships appear to general users in the Relationships section/
tab in the asset detail and in the Navigator.

Related assets may also appear during the asset Use/Download process.
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System-Supplied Relationships

Overview

User-defined asset relationships define the connection, interaction, or interdependence 
between assets, as explained in Relationship Labeling Conventions. Whereas, system-
supplied asset relationships are used for system-specific relationships within Oracle 
Enterprise Repository, such as allowing for more complex matches when doing asset 
updates. Therefore, users cannot create or delete system-supplied relationships, nor can 
they modify a system-supplied relationship’s direction. In order to view system-supplied 
relationships, they must be made visible by enabling the cmee.show-system-
supplied-relationships system setting, as described in the "General User 
Interface" section of the Administration Guide.

Viewing System-Supplied Relationships in the Asset Editor

Users can view system-supplied relationships in the Asset Editor if they have been 
applied to an asset by the system.

Relationships Tab

1.  In the Asset Editor, view an asset and select the Relationships tab. 

2.  The asset's relationships are divided into two sections, one for editable, user-
defined relationships and the other for the read-only, system-supplied relationships. 
All relationships to an asset are viewable in this manner.
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Configuring Relationship Types

Users cannot create or delete system-supplied relationships, nor can they modify a 
system-supplied relationship's direction, which is always read-only. However, users can 
edit the display Target and Source names, and can also enable the asset's availability for 
downloading. For more information on viewing other relationship types, see Using the 
Asset Editor.

1.  In the Asset Editor, select Configure Relationships from the Actions menu.

The Configure Relationships window opens.
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2.  To edit any System-Supplied Relationship, locate it in the list in the Configure 
Relationships window. 

3.  Click Edit.

The Edit Relationships window opens. (Same form as the Add Relationship 
window.)

4.  Make the appropriate changes to the Source Asset and Target Asset text boxes.

The ready-only, system-supplied direction affects the information displayed in the 
Source Asset and Target Asset text boxes. For example, in a two-way 
relationship, the target and source are interdependent, whereas Two-way -- order 
matters can be used to describe the relationship between sequential versions of an 
asset, i.e., the relationship between Asset v0.90 and Asset v1.0.

5.  Make the appropriate selection in the Make target assets available for download 
with the source asset check box. 

6.  Click OK. 

Viewing System-Supplied Relationships

●     Viewing Relationships - Similar to the Asset Editor, relationships displayed in the 
asset detail of Oracle Enterprise Repository are divided into two sections, one for 
user-defined relationships and the other for system-supplied applied relationships. 
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●     Use-Download - Users can download assets related by both traditional and 
system-supplied relationships. This feature can be enabled/disabled in the Asset 
Editor per relationship. 

●     Navigator - System-supplied relationships are viewable alongside traditional 
relationships in the Navigator. 
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Adding Files to an Asset

Actual code artifact files can be associated with an asset. The files are presented to users 
upon Use-Download. The files may be located in an artifact store, such as an SCM, or 
available through a URL. This procedure is performed in the Oracle Enterprise Repository 
Asset Editor.

1.  Use Search or other means to locate the asset to which a file will be added. 

2.  Locate the File Information element on the Overview tab.

3.  Click the Add button.

The Edit pop-up opens.

4.  Fill in the Name and Description text boxes. 

5.  Click the Edit button (next to the URL field).
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The Edit URL pop-up opens.

6.  Use the radio buttons to select the source of the file to be added.

�❍     Artifact Store File

1.  Select an item from the Host drop-down. (Configuration determines 
available selections.) 

2.  As necessary:
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■     Enter the appropriate additionalPathStructure/
fileName in the Path text box, or... 

■     Click the Browse button to browse to the file to be added. 

�❍     External File

1.  Enter the file URL in the URL text box 

2.  Click Test to verify that the URL is valid. 

7.  If necessary, a supplementary text file may be created and added to the file:

1.  Click the Text File radio button. 

2.  Select the type of text file from the Type drop-down. 

3.  Enter text as necessary in the File text box. 

8.  When finished, click OK to close the Edit URL pop-up. 

9.  Click OK to close the Edit pop-up.

The added file will now appear in the list in the File Information element.
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Working With UDDI Registries

Overview

The Asset Editor also enables access to UDDI from the tree. UDDI (Universal 
Description, Discovery and Integration) enables organizations to quickly, easily, and 
dynamically find assets on the Web and use them in their own initiatives. The UDDI 
Registry implements the UDDI specification and is the access point for external searches 
of the Internet or your organization's internal UDDI directory. Access to and from the 
UDDI Registry is performed using SOAP (Simple Object Access Protocol).

To enable UDDI access in the Oracle Enterprise Repository, the cmee.uddi.enabled 
system settings must be enabled by Oracle Enterprise Repository administrator. The 
UDDI Registry enables the addition of new Web services or other assets that your 
organization may find valuable over the course of time. Importing an item through the 
UDDI Registry places it in the Queued folder for the selected asset type; subsequently, 
the item or service undergoes the same submission and approval process as any internal 
item or service.

The information registered in the UDDI Registry includes:

●     Business entity
�❍     The business entity represents information about a business to which a 

service or asset belongs. The entity contains unique identifiers, the business 
name, a description of the business, basic contact information, and a URL 
that points to more information about the business. 

●     Service entity
�❍     The service entity is a list of the business services offered by the business 

entity. Each entry contains a description of the service, categories that 
describe the service, and pointers to reference information related to the 
service. 
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●     Specification pointers
�❍     Specification pointers are a list of binding templates that point to 

specifications about the service, and associate the service with a service 
type. 

●     Service types
�❍     Service types are defined by tModels, which specify information such as the 

tModel name, the name of the organization that published it, a list of 
categories that describe the service type, and pointers to technical 
specifications for the service type. 

Access to the UDDI feature depends on the options purchased or included with your 
specific instance of Oracle Enterprise Repository.

Using the UDDI Registry

Use the UDDI Registry to search for services and then import them into Oracle Enterprise 
Repository. (The UDDI Registry option must be enabled.)

This procedure is performed in the Asset Editor.

1.  Open the UDDI Registries folder in the tree. 

2.  Select a UDDI registry.

The selected UDDI registry opens in the Asset Editor.
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3.  Enter a search term in the Search text box. 

4.  Click the Search button. 

5.  Select a service from the list of results. 

6.  Click Import Service. 

7.  In the Import Service dialog box, enter a name and version number for the service, 
and select an asset type.
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8.  When finished, click OK.

The service or item appears in the tree, in the Submitted queue, under the 
assigned asset type.

9.  Proceed with asset registration. 
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File Downloads by Proxy

Overview

Oracle Enterprise Repository normally delivers asset payloads from a remote repository to 
the end user's browser through a browser redirect. (Exceptions include the use of 
ClearCase or an Oracle Enterprise Repository-controlled upload repository.)

When a username and password are required for repository access, they are passed to 
the user's browser. In certain circumstances it may be possible for the user to ascertain 
the username/password for the remote repository or to obtain a browsable path to gain 
unauthorized and unrecorded access to other files within that repository.

Oracle Enterprise Repository's Proxy Download Requests feature solves this problem 
by allowing Oracle Enterprise Repository to act as the user's proxy, eliminating the need 
for direct user access to the remote repository.

During the proxy process, Oracle Enterprise Repository downloads the files from the 
remote repository and then streams them to the end user. The repository username, 
password, and filepath are not passed to the end user's browser.

The Proxy Download Requests feature can also be used to provide access to files 
stored in repositories that are otherwise available only to limited segments of the 
organization's Oracle Enterprise Repository user base, as is the case when a repository 
instance located on a publicly accessible Web server must connect to a firewall-restricted 
file repository.

Configuration
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●     The proxy download feature supports only repositories using the following protocols:
�❍     HTTP 
�❍     HTTPS 
�❍     FTP 

●     Oracle Enterprise Repository must be able to open a network connection to the file 
repository. 

Enabling Proxy Download Requests

The procedure is performed in the Asset Editor.

1.  Open the Actions menu. 

2.  Click Configure Artifact Stores. 

3.  Select the appropriate artifact store from the list.

4.  Click Edit. 
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5.  Check the Proxy Download Requests option.

6.  Click OK to close the Edit Artifact Store window. 

7.  Click OK to close the Configure Artifact Store window.

Changes take immediate effect. All download requests for files in the selected 
artifact store are proxied, as are requests to view files in the Edit URL window in 
the Asset Editor.

Considerations
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Proxy downloaded files pass through the network from the file store, to Oracle Enterprise 
Repository, to the end user. Given the system performance implications of this process, 
we recommend the following limitations to the use of the Proxy Download Requests:

●     Do not use the Proxy Download Requests feature for files stored on otherwise 
publicly accessible servers. 

●     Do not use the proxy download feature for particularly large files. 
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The Producing Projects Feature

Overview

The Producing Projects feature tracks and reports on assets that were produced by 
projects. This level of traceability is essential to understanding and evaluating the return on 
investment in individual projects and in the project portfolio. The Producing Projects 
element appears in the detail display of assets.

This feature is standard in the base Oracle Enterprise Repository product.

Adding a Producing Project to an Asset

This procedure is performed in the Asset Editor.

1.  Select the asset to which the Producing Project is to be added. 

2.  Click the Add button in the Producing Projects section on the Overview tab.

The Add Producing Projects pop-up opens.

3.  Click the List All button in the Add Producing Projects pop-up to display a list of 
available projects in the left window.
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Projects can also be located by using the Search function in the Add Producing 
Projects pop-up.

4.  Select the appropriate project and use the arrow button (>>) to move the project to the 
window on the right. You can also double-click project names to move them back and 
forth. 

5.  Click OK to close the Add Producing Projects pop-up.

The selected project is listed in the Producing Projects section on the Overview tab.

6.  Save the asset and exit the Asset Editor.

The selected project now appears in the Producing Project(s) section in the asset 
detail in the Assets section of Oracle Enterprise Repository.
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A raw SCM repository is for storage of artifacts from an Eclipse-base import of a 
Composite Application. It is almost identical to a Raw URI store with the addition of a 
download URI. The additional field allows for us to store the path to the file on a client's 
machine as well as having a download URI that can be used by Oracle Enterprise 
Repository and other clients of Oracle Enterprise Repository.

Additional development documentation 
Additional REX documentation

To Configure SVN/CVS as an Artifact Store:

1.  Click the Edit / Manage Assets in the Oracle Enterprise Repository Assets screen. 
The Asset Editor opens. 

2.  Click Actions -> Configure Artifact Stores. The Configure Artifact Stores dialog 
box opens. 

3.  Click Add. The Create a New Artifact Store dialog box opens. 

4.  Enter the name of the artifact store in the Name field. 

5.  Select Raw SCM in the Type box. The options in the Create a New Artifact Store 
dialog box changes according to the type you have chosen.
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6.  Enter the remaining details in the Create a New Artifact Store dialog box:

�❍     Hostname: Enter the hostname for the artifact store. 
�❍     SCM Location: Enter the SCM location. 
�❍     SCM Type: Select CVS from the list. 
�❍     Download Path URI Suffix: Enter the suffix value for the download path URI. 
�❍     Download Path URI: Enter * http://username:password@VIEWCVVS/* in 

the download path URI. 
�❍     URL: URL appears in the URL field. 
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7.  Click OK. The artifact store that you just created appears in the Configure Artifact 
Stored dialog box. 

To edit an already existing artifact store, select the artifact store that you wish to edit and 
click the Edit button. The Edit Artifact Store dialog box opens. Now, modify the values 
and click OK to update.
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Using the Type Manager

Overview

Understanding Types

Each artifact in Oracle Enterprise Repository falls under one of three general headings:

●     Asset 
●     Compliance Template 
●     Policy 

Each of these headings is represented by a variety of Types:

●     Asset Types 
●     Compliance Template Types 
●     Policy Types 

These Types are patterns, various instances of which are created to accommodate the 
diverse artifacts that can be managed within Oracle Enterprise Repository. For example:

●     Application is an instance of an Asset Type. 

●     Project Profile is an instance of a Compliance Template Type. 

●     Regulatory Compliance Policy is an instance of a Policy Type. 

Types determine both the display of information for, and the taxonomy of, all of the 
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artifacts (assets/compliance templates/policies) in Oracle Enterprise Repository. Oracle 
Enterprise Repository ships with several Types. These may be modified, or new types 
can be created using the Type Manager.

The Type Manager controls the organization and display of information for each artifact 
as it appears in the Asset Editor and in the Asset Detail.

Launching the Type Manager

This procedure is performed in the Asset Editor.

1.  Select Manage Types in the Actions menu.

The Type Manager opens.

2.  Select an asset type, compliance template, or policy from the tree to view/edit its 
configuration. 

Type Manager Views

Each type has an Editor and a Viewer.
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Information relevant to the configuration of the Editor and the Viewer views for each type 
is stored in XML files in the database. The Type Manager loads the XML files into a GUI, 
which enables the creation, modification, and deletion of types. After the type is saved, 
the data is assembled in XML and loaded into the database.

The Editor

The Editor controls the organization and display of information for assets/compliance 
templates of the particular type as they appear in the Asset Editor.

The Editor display is divided into three sections:

●     General
�❍     Includes the type name, the usage status selector, the type icon selector, 
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and a Preview button, which displays the asset, compliance template, or 
policy type as seen via the Asset Editor. 

●     Tabs
�❍     Includes a list of available tabs for the type. These tabs correspond to tabs 

displayed in the Asset Editor view of an asset/compliance template. Click on 
any listed tab to display its elements in the Elements section, just below the 
Tabs section. 

●     Elements
�❍     The elements of any tab listed in the Tabs section are displayed here when 

the item is clicked. 

Several buttons appear to the right of the Tabs and Elements sections:  

●     Add 
●     Edit 
●     Remove 
●     Move Up 
●     Move Down 

These actions may be applied to any item listed in the Tabs or Elements sections. Simply 
select the item, and then click the appropriate button.

The elements listed below are required for valid Types. They may be renamed, but 
cannot be removed from a type.

●     Name 
●     Version 
●     Description 
●     File information 
●     Notification Email 
●     Keywords 

The Viewer
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The Viewer controls the organization and display of information for assets, compliance 
templates, or policies of the particular type as they appear in the Assets section of Oracle 
Enterprise Repository (the general user view of asset/compliance template information).

The Viewer display is divided into three main sections:

●     Hidden Elements
�❍     Lists all elements available for display.

■     Use the Edit button (on the right) to change the configuration of any 
listed element. 

■     Use the Display in Group button to assign the element to one of the 
two columns in the main asset display in Oracle Enterprise Repository. 

●     Groups
�❍     Includes Column One and Column Two. These correspond to the two main 

columns in the main asset display in Oracle Enterprise Repository. Use the 
buttons on the right to configure the elements in the respective columns. 
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●     Elements
�❍     Click on any item in Groups -- Column One or Groups -- Column Two to 

display the respective item's elements in the Elements section. Use the 
buttons on the right to configure these elements. 

Use Caution! Changes made to Types affect the display of all assets assigned to 
that type.

Creating a New Type

In order to preserve database integrity, only Types to which no assets are currently 
associated may be deleted.

Note: This action may alter reuse measurements.

1.  Select New in the File menu to open the Create New Type window.

2.  Enter the appropriate information in the Type Name text box. 

3.  In the Type for Defaults drop-down, select one of the existing Types as the basic 
template for the new type. 

4.  Click OK.

The new Type appears in the tree.
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Configuring Tabs to Support Registration Workflow

Overview

Tabs should be positioned on a Type in a logical sequence that accommodates the 
registration workflow. For example, in the Framework asset type (shipped with Oracle 
Enterprise Repository), it is intuitive to complete the General information first. The 
Documentation and Testing tabs, being very similar, are located near each other. The 
actual registration step, the last in the workflow process, is performed on the 
Administration tab. For that reason the Administration tab is system generated and 
intentionally fixed in its position.

Whenever a tab is approved, a TabApprovedEvent event is triggered. This event along 
with the tab name and certain other metadata is sent to the workflows for processing. This 
event is used by the Multi-Tier workflows where depending on the tab approved and 
depending on the configuration, the workflows will decide if the next tier in the approval 
process needs to be assigned or not.

Also, the users can wire the TabApprovedEvent event to any of the pre-defined 
workflows such as ChangeAssetLifecycle etc. So, this is also tied to the Tab names.

Adding Tabs

1.  Select the Type to be modified.
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2.  On the Editor tab, click Add in the Tabs section.

The Tab Information window opens.

3.  Enter the appropriate information in the Tab Name text box. 

4.  Click OK.

The name for the new tab appears in the Tabs section list.
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5.  Click Preview in the General section.

The preview window opens. The new tab is displayed.

6.  Close the Preview window. 

7.  On the File menu, click Save to save the changes. 

Change the Position of a Tab

1.  Select the Type to be modified.
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2.  On the Editor tab, select the tab to be moved.

3.  Click Move Up or Move Down, as appropriate.

Each click moves the tab one level. This example moves the selected tab from the 
bottom to the top of the list.

4.  Click Preview in the General section.

The preview window opens. Note new position of the tab.
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5.  On the File menu, click Save to save the changes. 

Editing Tabs

1.  Select the Type to be modified.

2.  On the Editor tab, select the tab to be edited.

3.  Click Edit. 

4.  Rename the tab.
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5.  Click OK. 

6.  On the File menu, click Save to save the changes. 

Deleting Tabs

Note: Deleting a tab deletes all data associated with the tab.

1.  Select the Type to be modified.

2.  On the Editor tab, select the tab to be deleted.
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3.  Click Remove.

A confirmation window appears.

4.  Click Yes.

The tab is deleted, and no longer appears in the tabs list or in the preview.

5.  On the File menu, click Save to save the changes. 

Important

All tabs may be deleted from a type, with the exception of those containing any of the 
following required elements:

●     Name 
●     Version 
●     Description 
●     File information 
●     Notification Email 
●     Keywords 

The system prevents the deletion of any tab containing any of these elements. In order to 
delete a tab containing any of these elements the elements must first be moved to 
another tab.
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Tab Elements

A variety of Elements can be added to tabs to accommodate the management and 
presentation of asset metadata. Some of these Elements are single-use: they are used 
only once in a type. Once assigned, single-use elements no longer appear in the list of 
available elements. The properties for each element type are listed below.

●     Text field -- contains data strings
�❍     Display Name

■     Element label that appears in the Asset Editor. 
�❍     Required

■     If checked, the field must be populated with data before the asset is 
saved. 

�❍     Indexed
■     If checked, the field appears in More Search Options for that type. 

�❍     Maximum Length
■     A validation rule for the maximum length of data in the field; accepts 

numerical entries. 

●     Numeric text field -- contains a single numeric value
�❍     Display Name

■     Element label that appears in the Asset Editor. 
�❍     Required

■     If checked, the field must be populated with data before the asset is 
saved. 

�❍     Indexed
■     If checked, the field appears in More Search Options for that type. 

�❍     Maximum Length
■     A validation rule for the maximum length of data in the field; accepts 

numerical entries. 

●     Date field -- contains a single date value
�❍     Display Name

■     Element label that appears in the Asset Editor. 
�❍     Required

■     If checked, the field must be populated with data before the asset is 
saved. 

�❍     Indexed
■     If checked, the field appears in More Search Options for that type. 
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●     URL -- contains a string that links to a URL
�❍     Display Name

■     Element label that appears in the Asset Editor. 
�❍     Required

■     If checked, the field must be populated with data before the asset is 
saved. 

�❍     Indexed
■     If checked, the field appears in More Search Options for that type. 

●     Check box -- contains a two-value checkbox that is either on or off.
�❍     Display Name

■     Element label that appears in the Asset Editor. 
�❍     Required

■     If checked, the field must be populated with data before the asset is 
saved. 

�❍     Checked by Default
■     If Yes is selected, the check box is automatically checked on new 

assets of the same type. 

●     Drop-down box -- contains a list of finite items
�❍     Display Name

■     Element label that appears in the Asset Editor. 
�❍     Required

■     If checked, the field must be populated with data before the asset is 
saved. 

�❍     Indexed
■     If checked, the field appears in More Search Options for that type. 

�❍     Acceptable Values
■     List of available data that populates the drop-down list; the Configure 

button enables configuration of the values. 

●     Editable list -- contains items that are either data or numerical values
�❍     Display Name

■     Element label that appears in the Asset Editor. 
�❍     Required

■     If checked, the field must be populated with data before the asset is 
saved. 

�❍     Indexed
■     If checked, the field appears in More Search Options for that type. 

�❍     Entry Field
■     Drop-down list of alphanumeric and numeric values; the Configure 

enables configuration of either alphanumeric or numeric values. 
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●     Multiple selection list -- contains data from the configured list from which items 
can be selected only once

�❍     Display Name
■     Element label that appears in the Asset Editor. 

�❍     Required
■     If checked, the field must be populated with data before the asset is 

saved. 
�❍     Indexed

■     If checked, the field appears in More Search Options for that type. 
�❍     Acceptable Values

■     List of available data that populates the drop-down list; the Configure 
button enables configuration of new or existing values. 

●     Table -- contains column and row information; columns correspond to elements, 
and rows correspond to data about the elements; available types include:

�❍     Text field 
�❍     Numeric Text Field 
�❍     URL 
�❍     Check box 
�❍     Drop-down box 
�❍     Table

■     Group Display Name
■     Element label that appears in the Asset Editor 

■     Item Display Name
■     Data entry area 

■     Required
■     If checked, the field must be populated with data before the 

asset is saved. 
■     Elements

■     Each element is a column of the table and follows the same 
rules as the element type. 

●     Categorization -- contains data relevant to the behavior of views in the Asset 
Editor; this can be used only once per type

�❍     Display Name
■     Element label that appears in the Asset Editor. 

�❍     Categorization Type
■     Drop-down list of various categorizations available in Oracle 

Enterprise Repository. 

●     Asset relationship -- contains data specific to the behavior of relationships; this 
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element type can be used only once per type to search for and establish a 
relationship between assets

�❍     Display Name
■     Element label that appears in the Asset Editor. 

●     Associated files -- contains data specific to the behavior of files; adding an 
associated create a link to the file

�❍     Display Name
■     Element label that appears in the Asset Editor. 

●     Contact selection -- contains data specific to the behavior of contacts; this 
element can be used only once per type to enable the creation of a contact or use 
of an existing contact

�❍     Display Name
■     Element label that appears in the Asset Editor. 

●     Producing projects -- contains data specific to the behavior of projects that 
produce assets as well as consume assets; this element can be used only once per 
type to enable producing projects.

�❍     Display Name
■     Element label that appears in the Asset Editor. 

●     JAR introspection -- contains data specific to the behavior of JAR files; this 
element can be used only once per type to add a fully qualified class name to the 
contents of the element

�❍     Display Name
■     Element label that appears in the Asset Editor. 

●     Requirement list/coupling -- contains data specific to the behavior of 
requirements; the element enables coupling based on the data (alphanumeric) 
entered in the element

�❍     Display Name
■     Element label that appears in the Asset Editor. 

●     UDDI link -- contains data specific to the behavior of UDDI registries; this element 
can be used only once per type to track a UDDI Registry URL and service key in 
the Asset Editor

�❍     Display Name
■     Element label that appears in the Asset Editor. 

●     Vendor selection -- contains data specific to the behavior of vendors. This element 
can be used only once per type and the names correspond to the names of the 
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vendors configured in the Configure Vendors option in the Asset Editor
�❍     Display Name

■     Element label that appears in the Asset Editor. 

●     Uploaded submission files -- contains data specific to the behavior of uploaded 
files; this element can be used only once per type to generate data based on the 
contents of the directory named the same as the asset ID in the upload path

�❍     Display Name
■     Element label that appears in the Asset Editor. 

●     Forum -- contains data specific to the behavior of forums; this element can be used 
only once per type

�❍     Display Name
■     Element label that appears in the Asset Editor. 

●     SFID -- contains data relevant to the behavior of Automated Usage Tracking; this 
can be used only once per type

�❍     Display Name
■     Element label that appears in the Asset Editor. 

●     Unique Element -- contains data relevant to the behavior of Unique ID; this can be 
used only once per type

�❍     Display Name
■     Element label that appears in the Asset Editor 

●     Project(s) to which template is applied -- contains data relevant to the behavior 
of Compliance Templates; this can be used only once per type

�❍     Display Name
■     Element label that appears in the Asset Editor 

Working with Elements

Numeric Text elements contain numeric information and are often used in conjunction 
with reports (see above). The following example adds a Numeric Text element to the 
Overview tab of a Type to create a reporting field.

1.  Select the Type to be modified.
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2.  On the Editor tab, click Add in the Elements section.

The Select an Element Type to Add window appears.
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3.  Select Numeric Text Field from the drop down. 

4.  Click OK.

The Edit Numeric Text Field window opens.

5.  Enter the appropriate information in the Display Name text box. 

6.  Checking Required means that assets of this type cannot be saved (in the Asset 
Editor) until the necessary data is supplied for all fields in this element. 

7.  Check Indexed to include the element fields in Oracle Enterprise Repository 
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searches. 

8.  Enter the appropriate information in the Minimum Value and Maximum Value 
fields. (See the list above for more information.) 

9.  When finished, click OK. 

Adding Images for Type Manager Icons

Icon Image Requirements

●     Size: 16x16 pixels 
●     Format: GIF format 
●     Save to: images/tree/enterprise/asset subdirectory in the host directory 

for Oracle Enterprise Repository installation files. 

1.  Locate the icons.xml file in the images/tree/enterprise/asset 
subdirectory. 

2.  Edit icons.xml as necessary to add icon elements for the new GIF images. 

3.  If it is open, close and reopen the Asset Editor. 

View/select available Type icons

This procedure is performed in the Type Manager.

1.  Select a Type.
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2.  On the Editor tab, click Assign in the General area.

The Select Icon window appears.
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3.  Select an icon from the drop-down list. 

4.  Click OK. 

5.  On the File menu, click Save to save the changes.

The new icon appears next to the Type in the list in the sidebar.
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Unique ID

Overview

Every asset submitted to Oracle Enterprise Repository is automatically tagged with an 
Oracle Enterprise Repository-specific ID number, which is used in the organization and 
management of assets. However, in certain environments or situations it may be 
advantageous for an organization to assign an additional custom identification key to 
specific assets. For example, a Unique ID key might be used to enforce uniqueness when 
relating an asset to a resource or asset in a system external to Oracle Enterprise 
Repository.

Oracle Enterprise Repository's Unique ID feature allows users with access to the Type 
Manager to add the Unique ID element to selected asset and/or compliance template 
types. Only one Unique ID element may be added per type. This Unique ID element then 
appears in the Asset Editor display of assets of the selected types.

Users with access to the Asset Editor can assign a Unique ID key to these assets/
compliance templates by adding the appropriate information in the Unique ID text box.

The uniqueness of each ID key can be enforced across the entire system, or limited to 
enforcement within a specific type. For example, when enforced across the entire system, 
no two assets, regardless of type, may be assigned the same Unique ID key. When 
enforced within a type, no two assets of the same type can be assigned the same key. 
However, the same Unique ID may be assigned multiple assets of different types. Within 
the Asset Editor, any attempt to save an asset with a Unique ID key that has already 
been assigned to another asset results in a error message.

The specific Type Manager configuration of the Unique ID element determines whether 
the element and information contained therein is visible to users in the asset detail display 
for individual assets in Oracle Enterprise Repository.
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Adding the Unique ID Element to a Type

This procedure is performed in the Type Manager.

Note: The properties associated with the Unique ID element must be enabled in the 
System Settings section of the Admin screen. See Properties.

1.  Select the Type to be modified.

2.  Select the tab to which the Unique ID element is to be added.

The elements assigned to that tab appear in the Elements section.
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3.  Click Add in the Elements section.

The Select an Element Type to Add pop-up opens.

4.  Select Unique Element from the drop-down. 

5.  Click OK.

The Edit Unique Element pop-up appears.
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6.  Enter the appropriate information in the Display Name text box in the Edit Unique 
Element pop-up. 

7.  Click OK.

The Unique ID element now appears in the Elements list.

8.  Save the changes.

Information necessary for custom reporting

In order to include the Unique ID element in a custom report, the schema information for 
this element is required. This metadata is stored in a table which can be joined to the 
Assets table and is populated based on the value of certain System Settings. The location 
of the metadata and rules that control it are specified in this section.

Table name:

●     UniqueElementValues 
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Fields:

●     assetid: ID of asset (foreign key to assets.id) 
●     assettypeid: ID of assettype (foreign key to assettypes.id) 
●     value: Unique value (varchar 4000) 

Note: A record will appear in the uniqueelementvalues table only if the 
asset's Unique ID element (as it appears in the Asset Editor) contains a 
value.

Properties

Two properties are associated with the unique element:

●     cmee.unique-element.enable
�❍     Enable/disable field for uniqueness. 

●     cmee.unique-element.per-assettype
�❍     True = uniqueness enforced within the asset type 
�❍     False = uniqueness enforced across the entire system. 

Note: Repeatedly toggling this property from true to false may result in unexpected 
system behavior.

Sample Scenarios:

1.  cmee.unique-element.per-assettype is set to true
�❍     Uniqueness is enforced within the asset type.

■     Multiple assets of different asset types can share the same Unique ID. 
■     Assets of the same asset type cannot share the same Unique ID. 

2.  cmee.unique-element.per-assettype is set to false
�❍     Uniqueness is enforced across the system.

■     No two assets, regardless of asset type, can share the same Unique 
ID.

■     Prior Unique ID assigments are unaffected by this property 
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change. However, attempts to save changes to assets may be 
rejected if the asset shares a Unique ID. 
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Common Metadata Viewers

There are two elements for Asset Types, Compliance Templates, and Policies that allow 
users to view XML-formatted metadata that is attached to an asset. One is based on 
XPath expressions and the other is based on XSLT transformations. Once added to an 
asset type, the metadata can be viewed in the Asset Editor and the Asset Detail views. 
Although the metadata will appear in the asset editor, it is for reference only. These 
viewers do not make the metadata editable.

XPath Common Metadata Viewer

When added to an asset type you need to specify a Common Metadata type and an 
XPath. When viewing an asset, if the asset has common metadata of that type, the XPath 
will be evaluated against the common metadata and the resulting items will be displayed 
in the asset as a simple list.

XSLT Common Metadata Viewer

These viewers are imported into Oracle Enterprise Repository. Once imported, they 
appear as elements that can be added to asset types. There is no configuration of the 
viewer apart from giving it a name. Once added to an asset type, assets of that type that 
contain common metadata compatible with the viewer will display the metadata as defined 
by the XSLT of the viewer.
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Viewing and Editing Type XML Schemas

Overview

The Type Manager includes features that allow users to view and edit the XML schemas 
for Asset Types, Compliance Templates, and Policy Types.

●     Export Schema
�❍     Displays the XML schema for the selected type. 
�❍     Available only to users who are assigned the Admin role. 
�❍     Accessed via the File menu in the Type Manager. 

●     XML Editor
�❍     Allows editing of XML source for the Editor and Viewer displays of all types, 

as seen via the Type Manager. 
�❍     Available to users in the Admin role, and to others, based on specific 

System Settings. 
�❍     Accessed via the Support menu in the Type Manager. 

Configuration

●     The Export Schema viewer is available only to users assigned to the Admin role. 

●     The Support menu displayed is determined by the following conditions:
�❍     If the user has Admin privileges.

■     The XML Editor option will be accessible in the Support menu. 

�❍     If the property cmee.asseteditor.allow.manual.proxy is enabled.
■     The manual proxy configuration option will be accessible in the 

Support menu. 

Using the Export Schema Feature
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This procedure is performed in the Type Manager.

1.  Select Export Schema from the File menu. 

2.  In the Load dialog box select an XML schema type from the Type list.

3.  Click OK.

The XML schema display opens.
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The display window does not allow editing of the schema. However, the schema 
may be saved to the local file system for later use. (Click Save in the window's File 
menu.)

Note: The schema may also be copied/pasted into a local document to use for 
validation of Type XML documents.

Using the Type XML Editor

The XML Editor allows unvalidated modifications of the XML source for Asset Types, 
Compliance Templates, and Policy Types.

Caution! Improper changes to the XML source may render all types inoperable.
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1.  In the Type Manager, select XML Editor from the Support menu.

The following warning message displays:

Changes made in the XML Editor are not validated and may render a Type 
unavailable!

2.  Click OK.

A blank window opens.

3.  Select Load from the File menu in the blank window. 

4.  In the Load dialog box, select the type of XML schema to be edited from the Type 
list.

5.  Select Editor or Viewer from the XML Type list. These selections refer to the 
Editor and Viewer tabs in the Type Manager. 

6.  Click OK.

The selected schema opens.
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7.  Edit the schema as necessary. 

8.  Save the changes by selecting Save on the File menu. 
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Assets in Progress

Overview

Oracle Enterprise Repository's Assets in Progress feature allows users to track the 
progress and availability of assets still in development. This allows organizations to realize 
compound gains in productivity by engaging asset producer, consumer, and maintenance 
teams in a collaborative process to increase the value of the asset portfolio in the natural 
course of software engineering. This feature helps organizations eliminate redundant 
development before it occurs. By exposing assets that are still in development, projects 
can include the use of these assets in their project plans, rather than wasting time and 
effort on redundant development.

Assets in progress appear in Oracle Enterprise Repository as Unregistered assets. The 
actual Registration Status of any asset in progress (as indicated in the Status column in 
search results and in the asset detail) is determined during asset submission.

When the Assets in Progress feature is enabled, any assets submitted via the Submit 
an Asset link on the Oracle Enterprise Repository Assets screen are automatically 
assigned the Unregistered status. They will appear in searches filtered for Unregistered 
assets.

Assets submitted via Submit an Asset enter the Submitted - Pending Review folder in 
the file tree in the Asset Editor.

Copyright (c) 2008, 2009, Oracle and/or its affiliates. All rights reserved. 100 of 106



Assets submitted via the Asset Editor may be designated as Unsubmitted or Submitted 
- Pending Review in the Initial State drop-down menu.

Assets in either state enter Oracle Enterprise Repository as Unregistered assets, and will 
appear in searches filtered for Unregistered assets.

Viewing Assets in Progress

Display a list of all Assets in Progress

This procedure is performed on the Oracle Enterprise Repository Assets screen.
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1.  Leave the Enter Search String text box blank. 

2.  Select All Types in the Type drop-down. 

3.  Select All Asset Functions in the Asset Function drop-down. 

4.  Select Unregistered from the the Registration Status drop-down menu.

5.  Click Search.

A list of all Assets in Progress will be displayed in the upper frame of the main 
pane.
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Enabling Assets in Progress

Two properties must be enabled in order to activate Assets in Progress. This procedure 
is performed on the Oracle Enterprise Repository Admin screen.

1.  Click System Settings in the left pane.

1.  Enter the property cmee.asset.in-progress in the Enable New System 
Setting text box. 

2.  Click Enable.

Assets in Progress appears in the list of settings in the main pane.

3.  Make sure the property is set to True. 

4.  Click Save. 

5.  Enter the property cmee.asset.in-progress.visible in the Enable New 
System Setting text box. 

6.  Click Enable.

View Assets in Progress appears in the list of settings in the main pane.
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7.  Make sure the property is set to True. 

8.  Click Save.

The Registration Status drop-down menu will now appear in the Search section 
on the Oracle Enterprise Repository Assets screen.

Disabling Assets in Progress

This procedure is performed on the Oracle Enterprise Repository Admin screen.

Note: Disabling the Assets in Progress feature prevents Asset Editor access to assets 
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in the Unsubmitted state. Assets in the Submitted - Pending Review state will remain 
accessible to the Asset Editor. Before disabling Assets in Progress it is recommended 
that all necessary assets be promoted from Unsubmitted to Submitted - Pending 
Review.

1.  Click System Settings. 

2.  Locate Assets in Progress in the list of settings in the main pane. 

3.  Set the Assets in Progress property to False. 

4.  Locate View Assets in Progress in the list of settings in the main pane. 

5.  Set the View Assets in Progress property to False. 

6.  Click Save. 
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Enabling Viewing of Assets in Progress Through an IDE

The Oracle Enterprise Repository Open API (part of the Oracle Enterprise Repository 
Extensibility Framework) makes it possible to enable viewing of both registered and 
unregistered assets in search results through an IDE.

Assuming this option is included in your installation of Oracle Enterprise Repository, the 
necessary property can be enabled through the following procedure, performed on the 
Oracle Enterprise Repository Admin page:

1.  Click System Settings in the left pane. 

2.  Enter the property cmee.asset.in-progress.openapi.visible in the 
Enable New System Setting text box.

3.  Click Enable.

View Assets in Progress - Open API appears in the list of properties in the main 
pane.

4.  Make sure the property is set to True. 

5.  Click Save. 

Copyright (c) 2008, 2009, Oracle and/or its affiliates. All rights reserved. 106 of 106




